
PowerPoint 2003

Lesson 1: The PowerPoint Window

Microsoft PowerPoint 2003, part of the Office 2003 suite, is a presentation graphics application. A presentation 
is a combination of slides, handouts, notes, and outlines all in one file. You can add text, graphics, photos, clip 
art, sound and video to your slides. PowerPoint 2003 can help you present a topic at work, home, or school.

By the end of this lesson, learners should be able to:

• Identify the parts of the PowerPoint Window 

• Recognize the slide views 

• Operate the Task Pane 

• Operate the pull-down menus 

The Parts of the PowerPoint Window

The PowerPoint Window has toolbars and panes to help you quickly create presentations. Most of the 
toolbars are common in Office applications but may feature options unique to PowerPoint.

• Title Bar - displays the document name followed by a program name. 

• Menu Bar - contains a list of options to manage and customize documents. 

• Standard Toolbar - contains shortcut buttons for the most popular commands. 

• Formatting Toolbar - contains buttons used for formatting. 

• Status Bar - displays slide position and the type of design in PowerPoint. 

• Drawing Toolbar - contains tools for drawing lines, shapes and objects. 

• Task Pane - located on the right side of the computer screen, this pane allows you to select tasks in 
different categories and allows you to quickly enhance your slides in a few steps. It provides quick 
access to the most common actions and features in PowerPoint. 

• Outline and Slides Tabbed Pane - allows the user to easily view the presentation in outline format 
(text), as well as a list of all the slides in the presentation (with visuals). 

• Help - provides quick access to Help topics. 

The default view for PowerPoint 2003 is the Tri-Pane View. This view, which opens when you launch 
PowerPoint, allows you to see multiple parts of a presentation at once.



The Outline and Slides Tabbed Panes are located on the left side of the screen. Click on the tabs to view an 
outline or a slide of your presentation. The tabs render differently based on the size of the pane.

You can show or hide PowerPoint's toolbars. Click on the View menu and choose Toolbar. Decide which 
ones you want to show or hide.

View Buttons and Slide Views

The view buttons at the left bottom corner of the screen allow three slide views: Normal View, Slide Sorter 
View and Slide Show.

The view buttons can be useful as you prepare your presentation. They control the way slides are displayed 
on the screen. Click a view button to see a different view.

Normal View contains the Outline and Slides Tabbed Panes on the left, the Slide pane in the center and 
the Task Pane on the right. 



The Outline View shows the text of your presentation for easy editing while Slides View shows text and 
graphics of the slide you're working on. Click on the tabs to switch between the two views. Under the center 
slide area is a place for notes.

You can hide or show the different panes in Normal View. To hide the Task Pane, click on the View menu 
and choose Task Pane. (The View menu also allows you to choose other views). To hide the Outline View and 
Slide Tabbed Panes, click on the X to the right of the Slides Tab. 

More Views

Here are some other views that may be useful as you create your presentations:

Slide Sorter View lets you see small versions of all the slides you have created. You can delete, copy, and 
move slides in this view.

Slide Show lets you see your presentation electronically as it will appear to an audience.

The Task Pane

The PowerPoint 2003 Task Pane is located on the right side of the screen. The down-pointing arrow in the 
top, right corner of the pane allows you to select different menus and tools. By default, the Task Pane appears 
when PowerPoint 2003 is launched.



The Slide Layout and Slide Design panes within the Task Pane help organize layouts, design templates, and 
color schemes. When you select a design option, your slides are quickly updated with the new look.

You can view the Slide Layout and Slide Design panes by clicking on the down-pointing arrow next to New 
Presentation in the Task Pane.

Select Slide Layout or Slide Design (Design Templates, Color Schemes, Animation Schemes). You'll learn 
more about using these panes later in this course.



Using the Task Pane

If you do not see the Task Pane on the right side of the PowerPoint window, you can easily access it. 

To Open the Task Pane:

• Click View Task Pane 

To View Different Panes:

• Click on the down-pointing arrow next to New Presentation and select different panes. 

• Once you open different panes, you can move through them by clicking on the backward and forward 
arrow buttons at the top of the task pane. 



To Close the Task Pane:

• Click the X on the right corner of the bar. 

You can hide or view the Task Pane by clicking on View  Task Pane. 

Pull-Down Menus

PowerPoint 2003's menu bar initially displays commands that you most often use. To view infrequently used 
commands from a menu, use pull-down menus. 

To View Commands in a Pull-Down Menu:

• Click on a menu in the menu bar. (File, Edit, View, Insert, etc.) 

• Move your mouse pointer over the double arrows at the bottom of the pull-down menu. 

Notice that some menus have black arrows to the right. Slide your mouse pointer over the arrow to view more 
options. These are called cascading menus. 



Challenge!

• Open Microsoft PowerPoint 2003 from the Start menu. 

• Review the parts of the PowerPoint window. 

• Familiarize yourself with the Task Pane. Click to see the other panes. 

• Click on the menu bar and view pull-down menus. 

• Click on the View Buttons. 

• Click on the Outline tab and the Slides tab. 

• Close PowerPoint and do not save anything you have done. 

Lesson 2: Creating a Blank Presentation

By the end of this lesson, learners should be able to:

• Choose and apply a slide layout 

• Add text to a placeholder 

• Save and close a presentation 

• Exit PowerPoint 

Creating a Blank Presentation

PowerPoint offers three ways to create a presentation: Blank presentation, From Design Template or From 
AutoContent Wizard.

The Blank presentation option is one of the more commonly used methods. It offers several blank slides with 
layouts for text and graphics.

To Create a Blank Presentation:

• Open PowerPoint. 

• A slide featuring a place for a title and subtitle appears by default. You may begin your presentation with 
this slide or choose a different slide layout. 



• The New Presentation Pane appears on the right side of the screen. 

• Under New, click Blank Presentation. 

• A list appears. 



Choosing a Slide Layout

As you work on your presentation, think about the type of layout you want. Do you want a slide with text and 
lots of clip art or one with text and a chart? PowerPoint offers many layout options.

To Choose a Slide Layout:

• Move your arrow pointer over the layouts or use the scroll bar in the Slide Layout Pane. 

• A gray bar appears on the right of each layout. 

• When you find a layout that you like, click the down-pointing arrow and choose Apply to Selected Slide. 

You can also click on the slide layout to apply it. Notice that the slide you are currently working on has a 
dark border in the Outline Pane.

Placeholders

Once you choose a layout for your slides, you can begin adding text, graphics or other items. You do this with 
placeholders - specials places within a slide where you can add content.

To Add Text to a Placeholder:

• Click on the placeholder. 

• Start typing. 



(You'll learn about inserting clip art and other graphics into placeholders later in this course)

Saving a Presentation

You can save, close, and exit presentations in PowerPoint just as you would while using other Microsoft 
applications.

To Save a Presentation:

• Click on File  Save. (Ctrl + S) 

• Choose the location where you want to save your presentation. (My Documents is a good place). 

• Type a name in the File Name box or keep the one that PowerPoint has provided. 



Closing a Presentation and Exiting PowerPoint

Once you've finishing working on your presentation, you can quickly close it.

To Close a Presentation:

• Click the X in the PowerPoint presentation window (Ctrl + W). 

• The PowerPoint application remains open and you can start a new presentation. (See next page for 
details). 

To Exit PowerPoint:

• Click the X in the far right top corner. 

OR

• Choose File  Exit. (Alt + F4) 

Before you exit PowerPoint, make sure that you save any work that you want to keep.

Creating a New Presentation Using the Traditional Method

Remember, after you have closed one presentation, you can easily start a new one while PowerPoint is still 
open by using the traditional new file creation method.

To Start a New Presentation:

• Click on File  New. (Ctrl + N) 

• In the New Presentation Pane, under New choose Blank Presentation. 



• Choose the design layout that you want. 

Remember, if your Task Pane disappears from the right side of the screen, click on View Task Pane.

Challenge!

In this series of challenges you are going to prepare a presentation about where you learn. This presentation 
can contain facts about the city or town where you learn and the place you use the GCFLearnFree.org® 

website (home, library, learning center, internet cafe, etc.). 

• Start PowerPoint. 

• Use the downward pointing arrow, beside Getting Started in the Task Pane, to select New 
Presentation Blank Presentation. 

• Choose a slide layout with a title and a subtitle placeholder. 

• Type Where I Learn in the title placeholder. 

• Type your name or username and today's date in the subtitle placeholder. 

For Example: 



• Save the document as Where I Learn. 

• Exit PowerPoint. 

Important Reminder: If you are using a public computer, such as one at a library or learning center, you 
may not be able to use the same computer each time. It is very important to understand the policies on saving 
documents to public computers. Some places do not allow you to use floppy disks due to the risk of computer 
viruses. Ask someone in charge of the public computers where you are. If you are unsure how you will keep a 
recent copy of the assignment, you can always email a copy of the document to yourself when you finish 
working on the document. 

Lesson 3: Inserting, Copying and Deleting Slides

Opening a Presentation

You can quickly open a presentation that you've previously saved by using the Task Pane.

To Open a Presentation

• Start PowerPoint. 

• In the Task Pane, click on From existing presentation and select the presentation that you want to 
open. 



OR

• Choose File  Open. 

• Navigate to the file you want to open. 

Inserting a New Slide

Once you've created your opening slide, you'll want to add more slides to your presentation.

To Insert a New Slide:

• Click on Insert New Slide. (Ctrl + M) 

• Move your arrow pointer over layouts or use the scroll bar and choose a slide layout. 



• A gray bar appears on the right 

• Click the down-pointing arrow and choose Insert New Slide. 

OR

• Click the New Slide button at the top of the screen 

• Move your arrow pointer over layouts or use the scroll bar and choose a design layout. 

• A gray bar appears on the right 

• Click the down-pointing arrow and choose Insert New Slide. 

Copying a Slide

Copying is another technique that you may use as you work on your slide presentation. For example, you may 
want to repeat a slide later in the presentation or copy a slide and make slight changes to it to make a different 
point.



To Copy a Slide:

• Click the slide you want to copy in the pane on the left. 

• Click on the Copy Button on the Standard Toolbar. (Ctrl + C) 

• Move the arrow pointer to where you want the copied slide to appear. 

OR

• Right click the slide you want to copy in the pane on the left. 

• Move the arrow pointer to where you want the copied slide to appear. 

• A horizontal cursor appears. 

• Click the Paste Button on the Standard Toolbar or right click Paste. (Ctrl + V) 

Note: This example of how to copy a slide was shown in the Slide Sorter View; however, the same 
instructions apply for copying a slide in Normal View. 

Deleting a Slide

Sometimes you may want to take one or more slides out of your presentation.

To Delete a Slide:

• Click the slide. 

• Press Delete on your keyboard. 

OR

• Right click the slide you want to delete in the pane to the left Delete Slide. 



You'll learn more about working with slides in different views in the next lesson.
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Challenge!

• Open the Where I Learn presentation you created in the previous challenge. 

• Insert a new slide with title and text placeholders. 

• Type the name of the city and state/province where you live in the title line. 

• Type details about this location in the bulleted list. 

For example: 



OR 

• Copy and paste the slide you just created. 

• Delete the copy you just made. 

• Insert a new slide with title and text placeholders. 

• Type the name of the place where you learn in the title placeholder. For example, if you use the 
GCFLearnFree.org website from your home, you would type Home in the title placeholder. 

• In the bulleted list type information about the location where you learn. 



For example: 

• Save and close your presentation. 

Lesson 4: Working with Slide Views

Slide Sorter View

As you are working on your presentation, you may want to change the order of your slides. You can rearrange 
slides in Slide Sorter View. It allows you to view miniature slides that you can drag and drop.

To Manipulate Slides in Slide Sorter View:

• Click on the Slide Sorter View button in the left bottom corner of the page. 

• Click the slide you want to move. 

• Hold down the left mouse button and drag the slide to its new location. A pointer with a box appears as 
you drag the slide. 



• Click on the Normal View button to return to Normal View. 

Working with Slides in Normal View

You can also easily move slides in Normal View. Remember, this is the Tri-Pane View that shows small slides 
on the left, a slide in the center and the Task Pane on the right.

To Move Slides in Normal View:

• Click on the Normal View button . 

• Click a slide in the left pane and drag and drop it to its new location. 

• Hold down the left mouse button and drag the slide to its new location. A pointer with a box appears as 
you drag the slide. 

To toggle between the different views in PowerPoint 2003, click on the View buttons or click on View 
Slide Sorter, Normal or Slide Show.



Changing and viewing Slides in Outline View

Outline View also allows you to make changes to slides. While you can drag and drop slides in this view, it's 
also useful for making changes to the text of your slides or for viewing multiple slides.

To View or Make Changes to Text in Outline View:

• Click the Outline View tab in the left pane. 

• An outline view of your slides appears with text. 

• Click on the small gray slide you want to make changes to. 

• Scroll through the slides in outline view. 

• Select the slide in the outline and then type changes directly onto the center slide. 

• You can view the text of all of your slides in this view. 

• Return to Normal View by clicking the Slides tab in the left pane. 

Viewing Slides in Slide Show View

After you have made some changes to your PowerPoint presentation, you can get an idea of how it will look 
as a slide show.

To View Slides in Slide Show View:

• Click on the Slide Show button  at the bottom left corner of the screen. 

OR

• Click on View Slide Show. 

• Click on each slide until you reach the end of the slide show. (black screen) 

• Click to exit and return to Normal View. 
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Challenge!

• Open the presentation, Where I Learn, which you have worked with in the last two challenges. 

• View the presentation in Slide Sorter View. Currently, you should have three slides. Your slides may look 
something like this: 



<> 

• Move the city/state slide (currently your second slide) so that it is the third slide in the slide show. 

• View the slides in Outline View. 

• Add an exclamation point (!) to the first slide after Where I Learn!. 

• View the slides in Slide Show View. 

• Save and close your presentation. 

Lesson 5: Applying a Design Template

Applying a Design Template

PowerPoint offers Design Templates to make it easy to create an attractive presentation. These templates 
come in a variety of colors and styles. You can apply a design to existing slides or begin a new presentation 
with a template.

To Begin a New Presentation with a Design Template:

• Open PowerPoint. 

• In the Task Pane under New, click on From Design Template. 



• A list of templates appears. 

• Move your mouse pointer through the different designs or use the scroll bar. 

• Click on the down-pointing arrow in the gray box next to the template that you like. 

• Choose Apply to All Slides. 

Adding a Design to an Existing Presentation

Do you have an existing presentation that you want to add a design to? PowerPoint makes it easy to enhance 
existing slides with a design template.

To Apply a Design to an Existing Presentation:

• Open PowerPoint. 

• In the Getting Started Task Pane, under Open, click on the presentation you want or select More... to 
browse through the files. 

• Click on the down-pointing arrow in the Getting Started pane and choose Slide Design - Design 
Templates. 

• A list of templates appears. 



• Move your mouse pointer through the different designs or use the scroll bar. 

• Click on the down-pointing arrow in the gray box next to the template that you like. 

• Choose Apply to All Slides. 

Applying a Design Template to Selected Slides

As you are working on your presentation, you can choose Apply to Selected Slides if you want one or more 
slides to have a different look.



A Closer View of Design Templates

If you want a closer look at the Design Templates, follow these steps: 

• With a presentation open, click on a template. 

• Click on the down-pointing arrow in the gray bar to the left. 

• Choose Show Large Previews. (It is now checked). 

• To return to the smaller views of the slides, click in the gray bar of any template and uncheck Show 
Large Previews. 

Choosing a Color Scheme

PowerPoint's Design Templates have pre-selected colors but you can choose your own color scheme. A 
color scheme is a combination of colors for the text and background of your slides.

To Choose a Different Color Scheme:

• In the Task Pane, click on the down-pointing arrow in the gray bar next and choose Slide Design - 
Color Schemes. 



• A list of color schemes appears. 

• Move your arrow pointer through the different color scheme options or use the scroll bar. 

• When you find a color scheme that you like, click on the down-pointing arrow in the gray box and 
choose Apply to All Slides. 

Challenge!

• Open the presentation, Where I Learn. 

• Apply a Design Template to your slides such as Capsules, Blends, Ripple, etc. Choose any design 
template other than the white default design. 

• View the various Color Schemes and apply a different color scheme to your slides. 

• Save and close your presentation. 

Lesson 6: Using the AutoContent Wizard

The AutoContent Wizard

PowerPoint has an AutoContent Wizard to help you create a presentation. This wizard provides several slides 
with different content guides. Presentation guides are available in several areas including General, Corporate, 
and Sales/Marketing.

To Use the AutoContent Wizard:

• In the Task Pane under New Presentation, choose From AutoContent Wizard. 



• Click Next to see the different presentation options that are available 

Choosing a Presentation Type

As you continue working in the Wizard, think about what you presentation best fits your needs. If you're not 
sure which choice to make, try General - Generic.

• Click Next after you have chosen a presentation type. 
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Type of Output

The next screen asks, What type of output will you use?

• Since you will likely be doing an On-screen presentation, click inside the circle next to On-screen 
presentation. Or, choose another presentation type. 

• Click Next. 

• On the next screen, you can type in your Presentation Title. Add a footer, if necessary. 



• Click Next. 

• The last AutoContent Wizard dialog box appears. 

• Click Finish. 

Your slides will appear and you can go through each one and make changes to the content. Edit the slides in 
Outline View in the left pane or type directly onto the slides in the center pane.

Making Changes to Content

When you use the AutoContent Wizard, the slides that result are a guide for your actual content. Make the 
changes necessary to fit your presentation.

For example, if you are working on a General - Generic presentation about your organization and how it helps 
the community, your first slide might look like this:

You may want to add or delete some of the slides based on your content or add a different design or color 
scheme.



Challenge!

Section 1: In this section of the challenge you are going to practice using the AutoContent wizard. You do not 
need to save this presentation. 

• Open the AutoContent Wizard. 

• Choose a Presentation Type. 

• Add a Presentation Title. 

• When you Finish, make changes the first page of the presentation. 

• Click through the presentation in Outline View. 

• Close this presentation without saving the document.

Section 2: In this section of the challenge you are going to make changes to the presentation you previously 
created, Where I Learn. This presentation should currently have three slides. 

• Open the Where I Learn presentation. 

• Insert a new slide with a title placeholder and a bulleted list placeholder (Title and Text). 

• Type a title and type some interesting information about where you learn. Format this information so it is 
not in a bulleted list. 

• Save and close the document.

Lesson 7: Formatting Text

Adding Text to an Original Slide

Many of PowerPoint's slides have text boxes already included and ready for you to add information. However, 
if you create an original slide you'll need to add a text box or two.

To Add Text to an Original Slide:

• Insert a blank New Slide. 

• Click on the Text Box button in the Drawing Toolbar. 

• Click and drag your mouse pointer to create a text box on the slide. 

OR

• Click on Insert Text Box. 



• Click and drag your mouse pointer to create a text box. 

The Formatting Toolbar

PowerPoint's default font or text type is Arial. However, you may want to change the font type, font size and 
more. Use the Formatting Toolbar to set the color, size, and overall look of your text. It doesn't matter 
whether the text is an original slide or is in a preset layout. 

Here are some of the formatting options:

• Font type 

• Font size 

• Bold, Italics, and Underline 

• Center, Align Left, and Align Right 

• Bullets and Numbering 

• Font color 

• Increase Font Size 

• Decrease Indent 

For more formatting buttons, click on the down-pointing arrow at the end of the toolbar. Choose Add or 
Remove Buttons - Formatting. Choose any additional options you want on the Formatting Toolbar. You can 
also choose Show Buttons on Two Rows.



Formatting Text

The Formatting Toolbar allows you to make many changes to your text to give it the look you want for your 
presentation.

To Format Text

• In the Formatting Toolbar, click on the down-pointing arrow OR button for the item you want to format. 

• For example, to set the font size for text you haven't typed yet, click on the down-pointing arrow next to 
the number and choose the font size. To change the font color, click on the down-pointing arrow next to 
the "underlined" A. 

• To make formatting changes to existing text, highlight the text and click on the down-pointing arrow OR 
button for the formatting change. 

Take some time to experiment with the different formatting options to decide what's best for your presentation.

The Format Menu

You can also use the Format menu to make formatting changes to the text in your presentation.

To Use the Format Menu:

• Click on Format Font. 

• A dialog box opens. 



• Choose the font, font style, and/or size. 

• Click OK 

Cut, Copy, and Paste

Once you've determined how your text will appear in your slides, you may need to cut copy or paste some 
information.

To Copy and Paste:

• Select the text you want to copy. 

• Click the copy button on the Standard Toolbar. (Ctrl + C) 

• Move your mouse pointer to the location on the slide where you want the text to appear. 

• Click the paste button on the Standard Toolbar. (Ctrl +V) 

To Cut and Paste:

• Select the text you want to cut. 

• Click the cut button on the Standard Toolbar. (Ctrl + X ) 

• Move your mouse pointer to the location on the slide where you want the text to appear. 



• Click the paste button on the Standard Toolbar. (Ctrl +V) 

The keyboard shortcuts - Ctrl + C, Ctrl + X, and Ctrl + V - can help make cutting, copying and pasting 
faster. If you don't already know them, learn these shortcuts.

Challenge!
In this series of challenges you will create a presentation about how you spend your free time (i.e., what your 
hobbies are). PowerPoint is a great program and it allows you to be creative with the way you display 
information, so have fun! 

• Open PowerPoint. 

• Choose a slide with a title and a subtitle placeholder. 

• Type the title How I Spend My Free Time. 

o Format the title using a 44 point Arial font. Make the title bold and in some color other than the default 
black.

• Type a subtitle with your name or GCF username and today's date. 

o Format the subtitle using a 28 point, Arial font. 

• Insert a Title and Text placeholder slide. 

• Type the title My Hobbies Are... on that slide. 

• Type at least three things you like to do in your free time in the bulleted list text placeholder. 

• Insert a Blank Slide. 

• Add a text box and type some information about the first item in your bulleted list that is on the 
previous slide, My Hobbies Are... 

• Format slide 2 and 3 with whatever font and font size you wish. 

For example: 

• Apply a design template to your presentation, if you wish. 



• Save your presentation as My Hobbies and close PowerPoint. 

Lesson 8: Formatting Bulleted and Numbered Lists

Bulleted Lists

PowerPoint provides several bulleted lists slides for you to choose from for your presentation. You can use 
these slides or create bulleted list slides of your own.

Bullets can be dots, check marks, arrows, squares and more.

Picture bullets - colorful bullets in various shapes - are also available. 



Formatting a Bulleted List

You can format the look of bullets from the Format menu.

To Format a Bulleted List:

• Place your cursor in the section of the slide you want your bullet or bulleted list. Click on Format  
Bullets and Numbering. 

• A dialog box opens. Make sure the Bulleted tab is selected. 



• Choose the bullet style that you want from the examples that appear on the screen or click Picture and 
choose a style from the bullets that appear. (You can also choose size and color). 

• Click OK. 

Customizing a Bulleted List

If you don't like the traditional bullets or the picture bullets that PowerPoint offers, you can customize your 
own.

To Customize a Bulleted List:

• Place your cursor in the section of the slide you want your bullet or bulleted list. Click on Format  
Bullets and Numbering. 

• A dialog box appears. Make sure the Bulleted tab is selected. 



• Click on Customize near the bottom right corner of the dialog box. 

• A dialog box appears. 

• Choose a symbol from the list that appears. Note that you can change the font by clicking on font in the upper 
left corner of the dialog box. 

• Click OK. 
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Formatting a Numbered List

PowerPoint also gives you different options for formatting a numbered list.

To Format a Numbered List:



• Place your cursor in the section of the slide you want your bullet or bulleted list. Click on Format  Bullets 
and Numbering. 

• A dialog box opens. Make sure the Numbered tab is selected. 

• Choose the number style that you want. (You can also choose size, color, and the number you wish to 
start from. 

• Click OK. 
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Challenge!

• Open the presentation, My Hobbies, which you created earlier. 

• Insert a new slide with title and text placeholders. This is the fourth slide in your presentation. 

• Type a title for the slide. You may want this slide to be about the second hobby on your list from slide 2, 
My Hobbies Are.... 

• Format a different bullet style for the slide. 

• Type a list of things related to the topic of the slide. 

For example: 



• Save and close the document. 

Lesson 9: Adding Clip Art and Pictures

Inserting Clip Art into a Slide

Clip art is a collection of graphical images. You can easily enhance your presentation with clip art in a few 
easy steps. 

To Insert Clip Art into a Slide:

• In the Outline view in the left pane, select the slide in which you want the clip art to appear. 

• Click the Clip Art button on the Drawing Toolbar. 

OR

• Select the slide you want to work on. 

• Click on the down-pointing arrow in the Task Pane Clip Art. 

If you are working with a slide that has an icon for clip art, click on the icon. You'll learn more about this 
later in this lesson.

Searching for Clip Art

Once you activate the Clip Art option, a search menu appears on the screen. 



To Search for Clip Art

• With the Search dialog box open, type the name of the image that you are looking for. For example, 
people, buildings, winter. 

• Click on Go. 

• Click on the clip art that you want to insert. 

• Click OK. 

• The clip art appears in your slide. 

You can move or resize clip art and other content once it has been inserted into a slide. You'll learn more 
about this later in this lesson.
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Searching for Clip Art on the Web



To find a larger selection of clip art, you can browse for clip art on the Web. To begin, make sure that you are 
logged onto the Internet.

To Search for Clip Art on the Web

• With the Search dialog box open, type the name of what you are looking for. For example, people, 
buildings, winter. 

• Under Search in:, click the down-pointing arrow next to Selected collections and check the box next 
to Web Collections. 

• Browse through the different clip art options. 

• Click on the clip art that you want to insert. 
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Inserting Pictures from File

Adding pictures to your presentation may also help engage the audience's attention. You can insert pictures 
that you have on file on your computer.

To Insert a Picture from File:

• Click on Insert Picture From File. 

• Navigate to the folder where you've saved your picture. 

• Click on the picture you want to insert into the slide. 

OR



• Click the Insert Picture button on the Drawing Toolbar. 

• Navigate to the picture that you want to use. 

• Select the picture and click Insert. 

Inserting Pictures or Clip Art Using a Slide Design Layout

Some slide layouts already have icons for clip art and pictures. PowerPoint allows you to insert pictures 
though these slide design layouts. 

To Insert Pictures Using a Slide Design Layout:

• Browse the slide design layouts to find one with an icon for a picture. 

• Click on the picture icon. 

• Navigate to the picture you want to insert. 

• Select the picture and click Insert. 

Resizing Pictures and Clip Art

Once you insert clip art or a picture, you may need to resize it to better fit your slide.

To Resize Pictures or Clip Art:

• Click the cursor the edge of the graphic and a resizing handle appears. A resizing handle is a black, 
double-headed arrow that changes to a "plus sign", + ,once you start resizing the image: 

• Drag the graphic to the size that you want. 



Challenge!

• Open your My Hobbies presentation. 

• Select the fourth slide. 

• Choose a Title, Text and Contents layout from the list in the Slide Layouts pane. (Make sure it 
contains placeholders for clip art and a bulleted list.) 

• Click Apply to Selected Slide. 

o You now have a slide with a bulleted list and a place for clip art.

• Click on Insert Clip Art. 

• Insert clip art to enhance this slide, when the Select Picture dialog box appears. 

• Close and save your presentation. 

Lesson 10: Adding Charts, Diagrams and Tables

Inserting a Chart

PowerPoint allows you to insert charts into your slide presentation to display different types of information to 
your audience.

To Insert a Chart:

• Insert a new slide with a title and a chart icon. 

• When the slide appears, click the Insert Chart icon. 



• A chart appears with a data sheet and sample data. 

• Replace the sample data in the data sheet with actual data that you want to present. The Y axis is for 
values or numbers. For example, number of hours worked or amount of money earned. The X axis is 
the label for the information. It now reads East, West, North. 

• You can delete some information in columns or rows of the sheet. Right click on the row or column and 
choose Cut, Delete or Clear Contents. 

• NOTE: You can expand the chart columns to fit your data or titles. Place your mouse pointer over the 
end of the column in the gray heading. A black cross with double arrows appears. Right click and 
drag the columns to the size you want. 

• To format column width, click on Format Column width. 

• Notice that as you enter the new data and titles etc., the chart on the slide changes to show this new 
information. 



If the datasheet disappears, double click on the chart and choose View Datasheet.

Setting a Maximum Value for a Chart

As you enter numbers in your chart, a maximum value for your chart will automatically be set, or you can set 
a maximum value of your own. The top value will automatically round up from the top value of the data that 
you are entering. So, depending on your data, it will be rounded to the nearest ten, hundred, or thousand. 

To Set a Maximum Value:

• Double click on a value on the side of the chart. 

• The Format Axis dialog box appears. 

• Click on the Scale tab. 

• Change the number for Maximum to the maximum number in your presentation. For example, 100. 



• Click OK. 

Choosing a Different Chart Type

If you don't want to use the chart that automatically appears when you double click the chart icon in a slide, 
you can choose a different chart type

To Choose a Different Chart Option:

• Click on Chart Chart Type. 

• A list of different charts appears, including Column, Bar, Line, Pie, and Pyramid. 



• Choose the best chart type for your presentation. 

• Click OK. 

Labeling a Chart

You may also want to label your chart with such information as the title and what the X and Y axes represent. 
In the default chart, the X axis is the horizontal information while the Y axis is the vertical information.

To Label a Chart:

• Click on Chart Chart Options. 

• A dialog box appears. 

• Click on the Titles tab (if it is not already selected). 

• In the box below Chart Title, type in the title. 



• In the box below Category (X) axis, type in the label for this information. It appears in the rows on the 
left of the datasheet and in a box on the right of the chart. 

• In the box below Value (Y) axis, type in the label for this information. 

• Click OK. 

To Change Text Alignment of Label:

• Right click on the text and choose Format Axis title. 

• Click on the Alignment tab. 

• Choose your text alignment and orientation options. 

• Click OK. 

Inserting a Diagram or Organization Chart

Does your presentation require a diagram or organization chart? An organization chart shows hierarchal 
relationships in a company or organization such as president, vice president etc. Diagrams are used to show 
relationships between various elements.

To Insert a Diagram or Organization Chart strong:

• Insert a new slide with a Diagram or Organization Chart icon. 

• Click on the Insert Diagram or Organization Chart icon. 



• When the Diagram Gallery dialog box appears, select a diagram or chart type. 

• Click OK. 

OR

• If working in a blank slide, click the Insert Diagram or Organization Chart button on the Drawing 
Toolbar. 



Inserting a Table

PowerPoint also gives you the option of displaying information within your presentation in a table.

To Insert a Table:

• Insert a new slide with a table icon. 

• Click on the Insert Table icon. 

• When the dialog box appears, set the number of columns and rows for your table. 

• Click OK. 

• Enter the data for your table. 

• To format the table, choose Format Table. 



• Click on the tabs and make any necessary changes. 

• Click OK. 

Challenge!

• Open the presentation, My Hobbies. 

• Insert a new slide that contains a chart icon. This will be the fifth slide in the presentation. 

• Decide whether you would like to insert a chart or a table. This chart or table needs to be related to the 
topic of your presentation, how you spend you free time/your hobbies . 

An example of a table related to your hobbies: You could create a table to track how many hours you 
spend on each activity for a week. To do this, insert a table with 8 columns and 4 rows. It might look like this:

An example of a chart related to your hobbies: You could create a chart that shows the estimated amount 
of time you spend on each hobby in a week (out of 168 hours (7 days * 24 hours). It might look like this: 



• Format the table or chart, as necessary. 

• Save and close your presentation. 

Lesson 11: Adding AutoShapes, WordArt and Hyperlinks

Inserting an AutoShape

PowerPoint provides many different items that you can use to enhance your slides. For example, an 
AutoShape can be a useful graphical element. AutoShapes include lines, arrows, banners, stars and other 
shapes that you can add to your presentation.

To Insert an AutoShape:

• Click Insert Pictures AutoShapes. 



• A small AutoShapes toolbar appears. 

• Click on the various options and a list of AutoShapes appears. 

• Choose the one for your presentation. 

• To format an AutoShape, right click on it and choose Format AutoShape. 

• A dialog box appears with various formatting options. 

OR

• Insert AutoShapes by clicking on the Drawing Toolbar at the bottom of the PowerPoint screen. A list of 
options appears. 

You can click and drag an AutoShape to increase its size and you can add text by choosing Insert Text 
Box. 

Inserting WordArt

WordArt is colorful and artful text that is available in a variety of styles. It allows you to create interesting 
titles, logos and text in your PowerPoint presentation.

To Insert Word Art:

• Click the WordArt button on the Drawing Toolbar. 

• The WordArt Gallery appears. 



• Choose the WordArt that best fits your slide presentation. 

• Click OK. 

• When the Edit WordArt Text dialog box appears, click on Your Text Here to add text. Type the text for 
your slide. You can also make any formatting changes to your font. 

• Click OK. 

• The WordArt appears in your slide. You may drag it to where you want it to appear on your slide. 

OR

• Click Insert Pictures Word Art. 

OR

• Click View Toolbars WordArt. 

Inserting a Hyperlink

PowerPoint also allows you to add hyperlinks to your slides to make them more interactive. A hyperlink can 
link to a web site which provides more information for your presentation.

To Insert a Hyperlink:



• Select the text in your document that you want to be a hyperlink. For example, www.gcflearnfree.org or 
Free Computer and Career Classes. 

• Click the Hyperlink button on the Standard Toolbar. 

(If this button does not show, you may want to add it to your toolbar by clicking on the down-pointing arrow at 
the end of the bar to display Toolbar Options. Click on Insert Hyperlink to add the button to your toolbar.

• Click the Existing File or Web Page button. 

• Type any text that you want to display. For example: Free Computer and Career Classes. This type will 
display instead of the web address. 

• Click OK. 

To make sure that the hyperlink works, click the Slide Show button and click on the link on the slide.

Challenge!
 Open the My Hobbies presentation. 
 Insert a new Title Only slide. This is your sixth and final slide. 
 Type a title for the slide. You may want to make this slide about the final hobby you have listed. 
 Insert a text box and type any necessary information related to the topic of the slide. 
 Insert an AutoShape, WordArt, or a Hyperlink onto the slide. 
 Save and close the presentation. 

Congratulations! You just completed your second assignment in PowerPoint 2003. Your Hobby Presentation 
should have a total of six slides, all with information about the things you do in your free time. 

©1998-2008 GCFLearnFree.org®. All rights reserved.

Lesson 12: Animating Slides

Animating Slides

Animating slides involves adding movement and sometimes sound to text or to the slides in a presentation. 
Animation can help create a livelier and more interesting slide show. PowerPoint provides some preset 
animation or allows you to customize the animation to fit your needs.

To Animate Slides using Animation Schemes:



• Open the PowerPoint presentation that you want to work on. 

• Select the slide that you want to animate. 

• In the Task Pane, click the down-pointing arrow and select Slide Design - Animation Schemes. 
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Choosing Animation for Your Slides

PowerPoint offers several options for animating your slides.

• Once you click on Slide Design Animation Schemes, the Slide Design pane appears with a list of 
options. 

• Click on an Animation Scheme that you think might work well in your presentation. (To preview your 
choice, make sure that the AutoPreview option is checked). 

• Preview different schemes to see which one best fits your slides. 



• You can apply different animation to each individual slide or click on APPLY TO ALL SLIDES. 

• Once you have applied your animation you can click on Play or Slide Show to view it. 

• Remove animation by selecting No Animation in the white box. 

Adding Custom Animation

You can also decide how text and other slide elements 'perform' by using custom animation. You can add 
effect, set speed and direction, and animate text on your own.

For example, you can decide how words or graphics enter or exit a slide. You may want to begin by adding 
effect to the titles in your presentation.

To Add Effect to Text:

• Open the presentation you want to add an effect to. 

• Click on the down-pointing arrow in the Task Pane Custom Animation. 

• Click the text that you want to add an effect to. 

• The Add Effect button will be activated. (Note the button is inactive until you select a part of the slide to 
work on) 

• Click on Add Effect Entrance. 

• A list of options appears for the entrance including Blinds, Box, Checkboard, and Fly In. 



• Decide how your text will appear on the screen and choose an option. 

• You can easily remove the effect by clicking Remove. Or, you can modify it by setting direction and 
speed underneath Modify. (PowerPoint lets you know the specific effect by listing it next to Modify. For 
example, Modify: Blinds). 

Emphasis and Exit

If you want to add an effect to make text or graphics grow, shrink, or change in another way, click on Add 
Effect Emphasis. Choose an effect. If you want to add an effect to have text or graphics exit the slide, 
click on Add Effect Exit. Choose the effect.

Setting Direction and Speed

Once you choose an effect, decide the direction for that effect. For example, you may want text to Fly In from 
the bottom. (Make sure your animation doesn't cross important graphics or text in your presentation).

To Set Direction:

• Underneath Modify in the Custom Animation pane, click on the down pointing arrow beneath 
Direction. (Note that direction options vary depending on the type of effect). 

• Choose the side of the slide from which you want the title to enter. 

• Underneath Modify next to Start, select With Previous (Animation starts automatically) or On Click 
(Animation starts when you click the mouse). 

Decide the speed at which you want effects to happen in your slides. You can choose very slow, slow, 
medium, fast or very fast to fit the rhythm of your presentation.

To Set Speed:

• Click on the down-pointing arrow underneath Speed and choose an option 



Animating a Bulleted List

A bulleted list may be another area that you might want to animate.

To Add Animation to a Bulleted List:

• Open the slide with the bulleted list you want to animate. 

• Click on the text box that contains the text you want to animate. 

• Click on the down-pointing arrow in the Task Pane Custom Animation. 

• The Add Effect button is now active. 
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Controlling Your Text

With the Add Effect button active, you can control the text in your bulleted list:



To Set Animation in a Bulleted List:

• Select the line of text you want to animate. 

• Once a line is selected, the Add Effect button becomes active. 

• Select whether you would like to add Entrance, Emphasis, Exit, and/or Motion Paths. 

• Using the downward pointing arrow to the right of each category: 

o Decide if you want this animation to occur On the Click, With Previous, or After Previous. 

o Select the Direction the animation will occur (direction options will differ depending on the animation. 

o Choose a Speed for the animation.

• To make changes to an animation, simply locate the number of the animation you wish to change and 
use the downward pointing arrow to the right of that numbered animation. 

• To set the direction/timing, you can select Effect Options from the menu. 

o A dialog box appears. 

o Click on the Text Animation tab. 



o The default option is By 1st level paragraphs. This is the level for the main bullet points. Bullets points 
will enter one at a time on the slide 

o If you want the bullet points to enter as a group, choose As one object. 

If you have multiple levels of bullets in a slide and you want to animate all levels, choose by 2nd level 
paragraphs if you have 2nd level bullets, and choose by 3rd level paragraphs if you have three levels of 
bullets etc.

Challenge!
In this series of challenges you will complete one of the PowerPoint presentations you have been working on. 
Decide whether you would like to continue working on your My Hobbies presentation or the Where I Learn 
presentation. 

• Open the presentation you would like to continue working on. 

• Add an Entrance effect to the title on the first slide in your presentation. Have the text Fly In. 

• Set the speed and direction-- Have the text come in from the left -- very fast. 

• Save your changes. 

• Select the second slide. 

• Apply the same Entrance effect to the title of this slide as you did for the first slide. (Fly In from left - 
very fast). 

• Animate the bulleted list by having all of the bullets Fly In as one object from the left at medium 
speed. 

• Save your changes and close the presentation. 

Lesson 13: Creating a Slide Master

The Slide Master

If you work for a company, you may be asked to prepare long presentations. Or, you may want to prepare 
slides about a special event or occasion. A Slide Master allows you to create a presentation with different 
types of slides but enable them to all have the same "look". 

The elements that you add to the Slide Master - such as a company logo, background, and font color - will be 
applied to all of your slides.

Creating a Slide Master

If you have a Slide Master, you don't have to format every single slide in a presentation with the same basic 
design and text.

To Create a Slide Master:

• Start a new presentation or open an existing one. 

• Click on View Master  Slide Master. 

• A slide with placeholders appears. 



• Click on Format  Background. 

• A dialog box appears. 

• Choose a background color. For more colors, click on More Colors. 

• Select the text in the Master title style placeholder. 

• Click on the down-pointing arrow next to the font in the Formatting toolbar. 

OR

• Choose Format Font and choose a font, font color and font style. Close Master View to save 
changes. 

Choosing Fonts for Levels of the Slide Master

As you continue working on your Slide Master, notice that the Master text styles placeholder contains a model 
of up to five bullets in which the text gets smaller for each level.



In the Slide Master, the font sizes are pre-selected. The sizes are based on what a normal person is able to 
read from a reasonable distance. You can change the font size, but this is fine-tuning that you might want to 
do later.

Generally, you should keep the text the same color for the title and all text levels.

To Edit the Text Styles for Each Level:

• Start a new presentation or open an existing one. 

• Click on View Master Slide Master. 

• Select the text and then choose a font and font color in the Formatting Toolbar. 

Viewing the Slide Master Elements

After creating or making changes to your Slide Master, you can view all of the basic design elements in your 
presentation.

To See the Slide Master Elements Applied:

• Click on View Normal. 

OR

• Click the Normal View button. 

• A slide or slide appears with the design elements of the Slide Master. 

The Title Master



When you create your Slide Master, you can also create a Title Master. This is the second slide that appears 
in the left pane when you are working on the Slide Master of a presentation using a Design Template.

This is a special slide for the title slide of your presentation. Remember, the Slide Master is a basic blueprint 
for all the slides of your presentation while the Title Master only addresses the elements of your title slide

To Edit the Title Master:

• Select the text in the Master title style placeholder. 

• Choose Format Background and choose a background color. 

• Click on the down-pointing arrow next to the font in the Formatting Toolbar. 

OR

• Choose Format Font and choose a font, font color and font style. 
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Challenge!

• Open the My Hobbies presentation or the Where I Learn presentation that you worked on in the 
previous challenge. 

• Design a Slide Master for this presentation. 

• Choose such elements as font and background color. 

• Type your name in the footer area. 

• Choose Normal View. 

• Insert a New Slide and notice that all the elements of the Slide Master are present in this new slide. 

• Save and close the presentation. 

Lesson 14: Spell Check and Printing

Using Spell Check

The Spell Check tool allows you to check your entire presentation for spelling errors. PowerPoint has a 
dictionary that you can customize with words typically not included in a standard dictionary.

To Use the Spell Check Tool:

• Click on Tools Spelling. 

OR

• Click the Spelling button on the Standard Toolbar. 



Scanning for Errors

Once you launch the Spell Check tool, a couple of scenarios can occur:

• PowerPoint quickly scans your presentation, searching for words that aren't in its dictionary. If there are 
no recognizable errors, a dialog box will appear stating that the spelling check is complete. 

• If there are possible spelling errors, the Spelling dialog box opens and offers you a number of options. 
Any unrecognized word appears in the Not in Dictionary box. 
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Spell Check Options

You can choose from one of the options in the Spelling dialog box: 

• Ignore - the word is correct and does not need to be added to the custom dictionary. 

• Ignore All - ignore all occurrences of the word. 

• Change - correct the word. 

• Change All - change all occurrences of the spelling of a word. 

• Add - add a word to the custom dictionary. 

• Suggest - PowerPoint suggests possible correct spellings of a word. Scroll through the list to find the 
correct spelling. Select the appropriate one and click the Change button. 

• AutoCorrect - automatically corrects many common spelling, typing, and grammatical errors. 



Once the entire presentation has been checked for spelling errors, and you have made your corrections or 
changes, click Close.

The Spell Check tool does not catch all errors. Be sure to read through your text carefully to find any 
typographical errors.

Previewing and Printing

Once you've corrected any errors in your document, it's time to print. PowerPoint 2003 allows you to preview 
your presentation before you print. You can preview and print slides, handouts, notes pages and outlines.

To Preview and Print a Presentation:

• Click on File Print Preview. 

OR

• Click the Print Preview button on the Standard Toolbar. 

• On the Print Preview Toolbar, click the down-pointing arrow next to the Print What box. 

• Select the layout that you want to preview and/or print. 

• Click the Close button to return to the presentation or choose Print to print the layout. 

Printing a Slide Presentation



If you don't want to preview your presentation in the various formats, you can simply print it.

To Print a Presentation:

• Click on File Print. 

• The Print dialog box opens. 

• Click the down-pointing arrow next to the Print What box. 

• Choose Slides, Notes, Handouts, or Outline. 

• Select the print range and number of copies. 

• Click OK. 

Challenge!

• Open the My Hobbies presentation or the Where I Learn presentation that you worked on in the 
previous challenge. 

• Use Spell Check to check your spelling. 

• Make any necessary corrections. 



• Preview Handouts (6 slides per page). 

• Print a Handout and keep this copy for your records. 

• Save and close the document. 

Lesson 15: Adding Transition

Adding Transition

Once you've completed all of your slides, create a cohesive presentation by adding transition. You can move 
from slide to slide with interesting transitions that affect the timing, entrance and exit of your slides. A transition 
is an effect that is applied to some or all of the slides in a presentation.

To Make Transitions from Slide to Slide:

• Click on Slide Show Slide Transition. 

OR

• In the Task Pane , click on the down-pointing arrow and select Slide Transition. 

• In the Slide Transition pane, choose the effect, you want from the drop-down menu. Ex. Blinds 
Horizontal, Blinds Vertical, Box In and Box Out. 

• Automatically preview each transition by clicking on it. (AutoPreview has to be selected). 

• Click Apply to All when you have chosen an effect. 

• Choose to advance from slide to slide on mouse click or automatically after the number of seconds 
that you select. 

• To see how your transition works, preview the slide show. Learn more about this later in this lesson. 

Some transitions work well with effects that have been added to text and graphics. Others do not. Preview 
a variety of transitions before finalizing your slide presentation.

Previewing a Slide Show



If you want to get an idea of what your completed show will look like to an audience, preview it. PowerPoint 
allows you to view your show in slide show format.

To Preview a Slide Show:

• Click on View Slide Show. (F5) 

OR

• Click on Slide Show View Show. 

OR

• Click on the Slide Show button to start the presentation. 

• To move to the next slide, click the mouse. (Space bar or Enter). 

• When the screen goes dark, click the screen to return to the PowerPoint screen. 

• You can exit the slide show by pressing ESC on the keyboard at any time. 

If you have set the slides to advance automatically, you don't need to click through the slides. Just sit 
back and enjoy the show. At the end of the show, click the left mouse button to return to the PowerPoint 
Screen.

Setting Up a Slide Show

Once you have added created a presentation and previewed it, set up a show. Take the necessary steps to 
make sure your slides are ready for a real audience.

To Set Up a Slide Show:

• Click on Slide Show Set Up Show. 



• The Set Up Show dialog box appears. 

• Choose your show type. Typically, it's presented by a speaker. 

• Choose which slides you will show. For example, all or slides 3 - 12. 

• Choose show options. You can leave these blank unless you're planning to run a show continuously 
on a kiosk or want to show it without animation etc. 

• Next, decide how you plan to advance your slides. 

• Click OK. 

Challenge!

• Open the My Hobbies presentation or the Where I Learn presentation that you worked on in the 
previous challenge. 

• Add transition. 

• Preview it in Slide Show view. 

• Set up your show. 

Lesson 16: Formatting a Text Box 

Formatting a Text Box



You can easily format a text box and modify elements such as the background color, line style and width, 
size, and position of the text box. 

To Insert a Text Box:

• Select Insert Text Box from the main menu. Your mouse pointer will change shape. 

• Click and drag your mouse to create the text box. 

• Release the mouse button. The text box will appear.

It is easiest to format a text box once you have entered text into it because you can see how it will appear on 
the slide. 

To Format a Text Box:

• Right-click the text box. 

• Select Format Text Box from the drop-down menu. The Format Text Box dialog box will appear.

< li>

To Format Colors and Lines: 

o Select the Colors and Lines tab. 

o Select the fill color from the drop-down menu. This color will appear as the background color of the text 
box. 

o Select the line color from the drop-down menu. 

o Select the line style from the drop-down menu. 

o Select the line width from the Line Weight drop-down menu. 

o Decide whether you would like to use a dashed line and then make your selection from the Dashed 
drop-down menu in the Line section. 

o Click OK to apply your selections.

To Format Size: 

o Select the Size tab. 

o Enter the text box height. 

o Enter the text box width. 

o Enter the degree amount to rotate the text box. 



o Click OK to apply your selections.

You can use your mouse to drag the corner of the text box and extend its size if your text box does not need 
to be a specific size. 

To Format Position: 

o Select the Position tab. 

o Enter the Horizontal position on the slide. 

o Enter the Vertical position on the slide. 

o Select whether to anchor the text box to the top, left corner or center. 

o Click OK to apply your selections.

You can use your mouse to move the text box on the slide; however, the Position tab allows you to control 
the precise location of the text box. This is extremely useful when you need a text box to appear in the same 
location on multiple slides. 

Challenge!

• Open a new, blank presentation. 

• Insert a text box. 

• Enter text in the text box. 

• Open the Format Text Box dialog box. 

• Change the background color to a shade of blue. 

• Choose a line style and weight. 

• Explore the settings on the Size tab. 

• Explore the settings on the Position tab. 

• Click OK to see how your selections affect the text box. 

• Close the presentation without saving the file. 

Lesson 17: Customizing Slide Design 

Customizing the Slide Design

When you select a design template, PowerPoint applies predefined design elements such as font style and 
size, background color, and bullet shape and color to each slide show. 

To Customize the Slide Design:

• Select Format Slide Design from the main menu. The Slide Design pane will appear. 

• Click the design template you like. By default, PowerPoint will apply this design to all the slides in the 
slide show; however, you can right-click the arrow beside each template to modify the default setting. 

• Click the Color Schemes link. 

• Select the color scheme you like. By default, PowerPoint will apply this design to all the slides in the 
slide show; however, you can right-click the arrow beside each template to modify the default setting. 



• Click the Edit Color Schemes link to modify specific elements of the color scheme.

• Select the element you would like to modify in the Scheme colors section. 

• Click Change Color. 

• Select the color you like on either the Custom or Standard dialog box tab. 

• Click OK. 

• Repeat the previous four steps until you have changed all the elements you wish. 

• Click Apply.

Challenge!

• Open a new, blank presentation. 

• Insert three slides of any layout design. 

• Apply any slide design template. 

• Apply a new color scheme to the design template. 

• Modify the background color. 

• Modify the accent color. 

• Close the presentation without saving the file.

Lesson 18: Compressing Pictures 

Compressing Pictures

PowerPoint files can be large and take up a lot of disc space if the presentation contains a lot of images. This 
can be a problem when you transmit the file by email or save it on a USB drive. To reduce the file size, you 



can compress the pictures. Compression is the reduction in file size in order to save space or transmission 
time. 

To Compress Pictures:

• Right-click the picture. 

• Select Format Picture from the menu. The Format Picture Dialog box will appear. 

• Select the Picture tab. 

• Click the Compress button. The Compress Pictures dialog box will appear. 

• Select Selected pictures or All pictures in document in the Apply to section. 

o If you choose Selected pictures, PowerPoint will compress only the pictures you select. 

o If you choose All pictures in document, PowerPoint will compress all the pictures in the presentation.

• Choose a resolution based on how you will use your presentation: Print, Web/Screen, or No Change.

• Select Compress Pictures and Delete cropped areas of pictures. 

• Click OK. 

• Click Apply.

Challenge!

• Open a new, blank presentation. 

• Insert at least three pictures into your presentation. 

• Compress all the pictures. 

• Close the presentation without saving the file.

Lesson 19: Grouping and Ungrouping Objects on a Slide 

Grouping and Ungrouping Objects

You may choose to use pictures, shapes, diagrams, text, and other objects in your PowerPoint presentation. If 
you do, there may be instances where you would like to group several of these objects together to make it 
easier to move them to different locations on the slide. This is called grouping.

To Group Objects:



• Select the first object with your mouse. 

• Press and hold the Ctrl key on your keyboard. Note: You will have to hold the Ctrl key until you select  
all objects you would like to group. 

• Select the second object with your mouse. 

• Continue to select all the objects you would like to group. 

• Release the Ctrl key. 

• Click the Draw menu.

• Select Group. A single set of handles will appear around the grouped object.

To Ungroup Objects:

• Select the object with your mouse. 

• Click the Draw menu. 

• Select Ungroup. A set of handles will appear around each object.

Challenge!

• Open a new, blank presentation. 

• Insert a picture from the clip art gallery. 

• Insert an arrow or other drawing object. 

• Insert a text box. 

• Enter text into the text box. 

• Group the text box, arrow, and clip art. 

• Move the object to the center of the slide. 

• Ungroup the object. 

• Close the presentation without saving the file.

Lesson 20: Ordering Objects on a Slide 

Ordering Objects

You may want to arrange multiple objects on a slide to overlap them or arrange them in a visually appealing 
way. PowerPoint allows you to order objects so that you have flexibility with how you design each slide.

To Order Objects:



• Select the object you wish to move. 

• Right-click the object. 

• Select Order. 

• Select one of the four options from the cascading menu and the object will move to the location you 
choose: 

o Bring to Front 

o Send to Back 

o Bring Forward 

o Send Backward

• Continue to order the objects on your slide until they appear the way you wish.

Challenge!

• Insert a text box into a slide. 

• Enter text into the text box. 

• Insert a picture into a slide. 

• Order the objects so the text box appears over the picture. 

• Insert an AutoShape and position it beneath the right corner of the picture. 

• Close the presentation without saving the file.

Lesson 21: Using the Set Timing Feature 

Using the Set Timing Feature

By default, PowerPoint is set to advance from one slide to the next when you click your mouse, use the down 
arrow key, or press the Page Down key. However, you can change this default setting and program your 
PowerPoint presentation slides to advance at specified intervals of time. In PowerPoint, this feature is 
called set timing. 

To Set Timing:

• Select Slide Show Slide Transition from the main menu. 

• Select View Slide Sorter. 

• Select all the slides using your mouse. 

• Deselect On mouse click in the Slide Transition task pane. 



• Select Automatically After.

• Enter the amount of time you would like to display each slide. 

• Click Apply to All Slides. 

Using the Set   Rehearsed   Timings Feature  

By default, PowerPoint is set to advance from one slide to the next when you manually advance the slide. You 
can change this default setting and program your PowerPoint presentation slides to advance at preset 
intervals of time. To do this, practice your presentation, and save the rehearsed timing.

For example, if you practice your presentation and spend seven seconds on your first slide and four seconds 
on your second slide you can then save the rehearsed timing. The next time you display your presentation, 
slide one will advance after seven seconds and slide two will advance after four seconds. 

To Rehearse and Save Timings:

• Select Slide Show Rehearse Timings from the main menu. The slide show will appear in Slide 
Show view and a Rehearsal dialog box will appear in the top, left part of the screen. 

• Practice your presentation. 



• Click the blue arrow in the Rehearsal dialog box to advance to the next slide. The timer will reset itself.

• Continue to practice your presentation and click the blue arrow to advance until you reach the final slide. 

• Choose Yes to save the rehearsed timings, or No to discard them when the Microsoft Office PowerPoint 
dialog box appears.

Challenge!

If you have not already done so in a previous Challenge, download and save the Sample PowerPoint 
presentation to complete this Challenge. Need help? How to Download a File

• Open the Sample PowerPoint file. 

• Use the rehearse timings feature to rehearse and save your presentation timings. 

• Save and close the file. 

• Open the file and play the presentation to make sure that you saved the rehearsed timings. 

• Close the file.

Lesson 23: PowerPoint Inserting Sound Effects 

Inserting Sound Effects

You can add sound effects to a slide show to gain your audience's attention; however, sometimes sound 
effects can be distract people from the content of your presentation. It will be up to you to decide when a 
sound effect will benefit your presentation.

To Insert a Sound Effect:

• Select Insert Movies and Sounds from the main menu. 

• Select the location of the sound clip: 

o Sound from Clip Organizer 

o Sound from File 

o Play CD Audio Track 

o Record Sound

In this example, select Sound from File. The Insert Sound dialog box will appear.

• Locate the sound file on your computer. 

• Select the file. 

http://www.gcflearnfree.org/content/downloads/SamplePowerPoint.ppt
http://www.gcflearnfree.org/PopUps/DownloadTips.aspx


• Click OK. The Microsoft Office PowerPoint dialog box will appear.

• Decide whether you want the sound to start Automatically when the slide appears or When Clicked. 
An icon representing the sound will appear.

To Hide the Sound Icon During the Slide Show:

• Right-click the icon. 

• Select Edit Sound Object. The Sound Options dialog box will appear. 

• Select Hide sound icon during slide show.

• Click OK.

You will still be able to see the icon in slide sorter view, but it will be hidden in slide show view.

Lesson 24: PowerPoint Adding Background Music from a CD 

Adding Background Music from a CD

You may want to add background music to some of your PowerPoint presentations. For example, if you 
create a slide show of family pictures, you may want play music in the background. Or, if you give a 
presentation at work, you could play music during the introduction slides before you speak. 

To Add Background Music from a CD:

• Select the first slide where you want the music to play. 

• Select Insert Movies and Sounds. 

• Select Play CD Audio Track. The Insert CD Audio dialog box will appear. 



• Verify that you have a CD in the CD drive of your computer. 

• Select the track number to start playing. 

• Select the track number where you want to end.

For example, if you want to only play tracks 5 and 6 of the CD, list track 5 as your start track and track 
6 as your end track. 

• Select Loop until Stopped to continue playing the music until the slide show is complete. 

• Select Hide sound icon during slide show. 

• Click OK. 

• Click Automatically to start the music when the slide appears. The CD sound icon will appear.

If you want to insert music from a digital file, select Insert Movies and Sounds Sound from File 
and follow the instructions that appear in the task pane. 

Lesson 25: PowerPoint Packaging a Presentation for CD 

Packaging a Presentation for CD

The Package for CD feature of PowerPoint 2003, called Pack 'n Go in previous versions, allows you to store 
one or more of your presentations on a CD or other disk drive. In addition to your presentation, PowerPoint 
also includes the PowerPoint Viewer by default so that you can run the packaged presentation on another 
computer even if PowerPoint is not installed on it. This is really helpful if you give a presentation at work or 
another event and are unsure if the computer you will use has PowerPoint installed.

To Package a Presentation for CD:

• Select File Package for CD from the main menu. 

• Enter a name for your CD. 

• Click Add Files and follow the instructions to add any extra files to the CD that you may need. If you link 
to files outside of your presentation, PowerPoint will automatically add those files. 

• Click Options. 

o Deselect the PowerPoint Viewer box if you are sure the computer you will use has PowerPoint 2003. 
By default, PowerPoint automatically includes the PowerPoint Viewer on the packaged CD. 



• Use the drop-down menu to select how you would like the presentation or presentations to play. 

o Play all presentations automatically in the specified order 

o Play only the first presentation automatically 

o Let the user select which presentation to view 

o Don't play the CD automatically

If you only have one presentation, leave the default setting, Play all presentations automatically in the 
specified order, selected.

• Verify Linked Files is selected if you link to other files in your presentation (this is the default selection). 

• Select Embedded TrueType Fonts to ensure the fonts you use in your presentation appear as you 
intend. 

• Create a password to open or modify your presentation, if you wish. 

• Click OK. 

• Choose Copy to CD.

Your computer must have a CD burner in order to save the presentation to CD. If you would like to copy the 
packaged presentation to another folder, click Copy to Folder and choose the location where you want to 
save it.




